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S32K3 SOFTWARE OFFERING:  

STANDARD AND PREM IUM 

Premium

SW

Standard

SW

Standard

HW S32K3

Security: Standard FW

Real-Time Drivers (RTD)

for AUTOSAR and non-AUTOSAR

Including Inter-Platform Comms 

Framework (IPCF) and Crypto Driver

Security: OEM specific FW

Safety: SAF + SCST

Application Specific SW
ISELED, etc.

STANDARD OFFERING:
Included in silicon price

PREMIUM OFFERING:
Application Specific SW: ISELED, etc.

Price adder on top of silicon price for selected PN

Premium Security: OEM specific firmware

Price adder on top of silicon price for selected PN

Premium Safety: 

S32 Safety Software Framework (SAF) 

+ Structural Core Self Test (SCST)

One-time license fee for combined SAF + SCST
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NXP SOFTWARE BASED ON REAL - T IM E D R IVERS

S32K3 MCUs Family 

SECURITY & OTA

OS / DRIVERS / SAFETY

MULTI CORE MANAGEMENT 

SERVICES / APPLICATION SPECIFIC SOFTWARE
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Real-Time Drivers (RTD)
Enhanced an updated AUTOSAR MCAL and non-AUTOSAR SDK

ISO 26262 compliant for all SW layers, production grade

Full compliance and coverage for both HW features and HW Ips, 

including Crypto Driver

Driver examples with default configurations

Unmatched HW scalability 

across General-Purpose & 

Integrated Solutions MCUs

combined with

Real-Time Drivers (RTD)

flexibility

One SW development environment

independently by the project 

requirements and specifications

One configuration tool 

and one driver set 

MEANING: less time and higher 

optimization of functionalities
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REAL - T IM E DRIVERS ( RTD)  

NEW AND INNOVATIVE DRIVERS SET  FOR AUTOSAR AND NON - AUTOSAR SOLUT IONS

Specifically focused on Real-Time Software

Targeted for Arm® Cortex®-M core based MCUs

Single package for each S32 MCU or Processor 

For AUTOSAR and NON-AUTOSAR systems

Real-Time Drivers (RTD)

NXP 

SDK

Complex
Device 
Drivers

AUTOSAR 
MCAL

AUTOSAR & non-AUTOSAR

ENHANCEMENTS:

· ISO 26262 Compliance for all SW layers

· AUTOSAR functionalities (e.g. multicore, user mode) are expanded also 

to  non-AUTOSAR environment (previously only available for AUTOSAR)

· Full IP and features coverage for both AUTOSAR and AUTOSAR

· Possible integration on platform level of middleware (FATFS for EEP, 

FEE for FLS derived from MCAL) and stacks (LIN, NFC, TCIP, ..)

· Driver examples with default configurations
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Real-Time Drivers (RTD)
ARCHITECTURE OVERVIEW
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REAL - T IM E DRIVERS ( RTD)  SOFTWARE PACKAGE

FOR S32  M ICROCONTROLLERS AND PROCESSORS

* REAL-TIME DRIVERS to support and improve actual MCAL functionalities 

High-Level Interfaces (HLI) based (and enhanced) 

on former MCAL environment 

· Production-qualified software abstraction of complex 

hardware features 

· Automotive-grade and production ready: 

SPICE/CMMI Level 3 compliant, MISRA 2012 tested

· Developed using SPICE Level 3 

and ISO 26262 standard compliant process

· Integration with NXP S32 Design Studio (S32DS) IDE

· Supports multiple toolchains: GCC, GHS, IAR

· Full coverage of IPs

through extensions: extra APIs added to standard ones –
e.g. Adc_EnableCtuControlMode to support configuration and functions 

related to CTU control mode of ADC unit

· AUTOSAR 4.4:

- Multicore 

- LIN “follower” support

- Security: TLS, Key Manager, Security Event Memory

· Documented source code, examples, cookbook & demos

for fast application start-up, using drag-drop functionality
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REAL - T IM E DRIVERS ( RTD)  SOFTWARE PACKAGE

FOR S32  M ICROCONTROLLERS AND PROCESSORS

* REAL-TIME DRIVERS to support and improve actual SDK functionalities 

Low-Level Interfaces (LLI) based (and enhanced) 

on former SDK environment 

· Automotive-grade and production ready: 

SPICE/CMMI Level 3 compliant, MISRA 2012 tested

· Complete drivers offering: 

- Low-level drivers for all MCU peripherals: 

FlexIO, UART, CAN FD, ISELED, etc.

- Optional middleware: LIN, TCP/IP, NFC

- Drivers for complementary NXP ICs: e.g. SBC

· FreeRTOS operating system

· Integration with NXP S32 Design Studio (S32DS) IDE

and 3rd party IDEs: KEIL, GHS Multi, IAR

· Supports multiple toolchains: GCC, GHS, IAR

· Documented source code, examples, cookbook & demos

for fast application start-up, using drag-drop functionality
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REAL - T IM E DRIVERS ( RTD)  SOFTWARE PACKAGE

FOR S32  M ICROCONTROLLERS AND PROCESSORS

* Additional specific SW package to the REAL-TIME DRIVERS (RTD)

Additional specific SW packages and Configuration Tools

One configuration tool can be selected for the development: EB tresos or S32 Config Tool (S32CT) 

→ aiming to develop S32CT with AUTOSAR functionalities

· Stacks and Libraries available in both 

AUTOSAR and non-AUTOSAR contexts.

Can be plugged into:

- High-Level Interface (AUTOSAR compliant)

- Low-Level Interface

· Demo application code available for:

- Provided libraries & stacks

- High-Level Interface (AUTOSAR compliant) layer

- Low-Level Interfaces layer
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ERROR M ANAGEM ENT BETWEEN M CAL/SDK AND RTD

The error detection and reporting mechanism for RTD is tailored for the target application type:

· HL API

✓ For the high-level layer, which is mainly intended for usage in AUTOSAR applications, error management follows the

standard specifications for DET & DEM. RTD provides a “stub” implementation of these AUTOSAR modules, which can be used or overwritten by the 

customer application. 

✓ Most of the APIs in consisting the AUTOSAR compliant HL API return Std_ReturnType (E_OK/E_NOT_OK). 

The specific error can then be retrieved by calling the dedicated APIs in DEM/DET.

TIPS: Development errors are always reported using DET; 

runtime may be reported using DEM or DET, depending on the impact they have on the application integrity.

· IP API

The errors reported by the IP layer are still split in two categories:

− Development errors: usually parameters checking but not only, these errors are checked using DevAssert function; in case an error is detected, this 

will halt the program execution in the default implementation. The default behavior of DevAssert function can also be overwritten by the application. 

This mechanism is almost identical to the DEV_ASSERT functionality in older SDK, the only improvement being that these statements are now 

enabled/disabled for each driver separately, as opposed to the SDK approach where this was a global configuration (check the picture below).

− Runtime errors: as opposed to the SDK, where all runtime errors reported by drivers were grouped in the generic enumeration called status_t, the 

RTD define a set of runtime errors per driver. The naming convention for these errors is <IP_Name>_Ip_StatusType, as shown is the example below:

✓ Each driver defines the set of errors that can be reported by the controlled IP; these errors can either be used by the non-AUTOSAR application 

implemented on top of the IP layer for retrieving the status of the driver, or further fed into the high-level state machine of the layers on top. 
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CONFIGURATION F ILES D IFF  BETWEEN M CAL/SDK AND RTD

The configuration data files are now split following a more granular

approach to ensure the possibility of using the IP drivers stand-alone.

From a functional point of view, all the data that is needed in an

AUTOSAR application will be exported through the HLD files, so

nothing changes in the application flow.
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M APPING BETWEEN RTD DRIVERS AND S32K3XX PERIPHERALS 

• Add UART support as complex driver 
for MCAL 4.4

• Add Flexio_SENT to support SENT
communication

• OsIf can support FreeRTOS and 
AUTOSAR OS as well as bare-metal 
timer, but no semaphore, mutex and 
queue support

• REG_PROT is included in BASE

• Functional safety related driver, such as 
MPU and XRDC are included in 
Resource Manager as complex driver

• FLS also includes QuadSPI external 
Flash memory, EEP is a standard 
MCAL for D-Flash emulated EEPROM 
implementation.

• All RTD drivers have timeout and 
multicore support per AUTOSAR 4.4 
standard and S32K3xx multi-core 
architecture required.
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CUSTOM ER FACING:  

ONE PACKAGE FOR AUTOSAR &  NON - AUTOSAR ENVIRONMENTS 

HL Interface 
Std AUTOSAR + non-AUTOSAR

Generic 

Configuration 
not HW or Platform dependent  

IP

Specific Configuration

IPL Interface
Dedicated to all functionalities 

Supporting AUTOSAR and non-AUTOSAR

Supporting non-AUTOSAR

IPL (IP Layer):
• Peripheral specific layer implementing support for all IP features

• Constant for the same IP across platforms. 

• Dedicated to export all hardware functionalities

• IP layer to come with standalone ISO 26262 compliance

HL (High Layer):
• Implements the standard APIs described into the AUTOSAR specifications

• Implements the APIs extensions based on:

• Specific customer requirements

• IP features exposed from layer below

*

*

RTD offers both abstracted/standardized interfaces and HW specific interfaces (exported by the IPL Interface)

These two interface types are exclusive, cannot be used at the same time

* as part of S32 Configuration Tool (S32CT) and EB tresos
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REAL - T IM E DRIVERS ( RTD)  – ARCHITECTURE 

Depending on the context wanted to be used by the upper layer, a specific interface must be used:

AUTOSAR context:

− High Level Interface usage

non-AUTOSAR context:

− High Level Interface usage

or

− IP Layer (ex-SDK)

AUTOSAR = ASR

non-AUTOSAR = nonASR



1 5PUBLIC

REAL - T IM E DRIVERS ( RTD)  – CONFIGURATION SCHEME

TRESOS S32CT

<MSN>_Cfg.c/h

<MSN>_Ipw_Cfg.c/h

<IP>[_<MSN>]_Ip_Cfg.c/h

The configuration output (c/h files) 

shall be identical with both tools*

If the HL is used in the application, 

the initialization must be done with 

the config from <MSN>_Cfg.c/h

If the IP layer is used in the 

application, the initialization must be 

done with the config from 

<IP>[_<MSN>]_Ip_Cfg.c/h
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REAL - T IM E DRIVERS ( RTD)  – LAYERED ARCHITECTURE

RTD High-Level Interface (HLI) Layer:

• Generic cross-NPIs (up to 100% reuse)

• Implements APIs called by the RTE/App Level:

• Implements standard AUTOSAR APIs

• Implements AUTOSAR API extensions & non-AUTOSAR APIs for NXP HW specifics

WDG

WDG_IPW

(S32CC)

WDG_IPW

(S32K1)

WDOG_IPSWT_IP

WDG_IPW

(RRU2)
RTD IP Wrapper Layer:

• This is the code that changes between NPIs.

• Maps the generic HLI APIs to the IP specific ones (LLI APIs).

RTD Low-Level Interface (LLI)  Layer: 

• IP Specific Software Layer that implements IP (µC) specific functionalities

• Constant (full reuse) for the same IP across NPIs 

and the same AUTOSAR versions (up to 100% reuse)
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INSTALL GUIDE
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1)  LOG IN  WITH  YOUR CREDENTIALS

Login at NXP.com with your credentials

Select 

Software Licensing and Support

View your account
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2)  DOWNLOAD:  S32K3 STANDARD SOFTWARE PACKAGE

Login your account on NXP website, and download the S32K3 Standard Software from:

https://www.nxp.com/webapp/swlicensing/sso/downloadSoftware.sp?catid=SW32K3-STDSW-D

Make sure to login your account first. 

Then click link to access the available 

Automotive SW – S32K3 Standard Software

https://www.nxp.com/webapp/swlicensing/sso/downloadSoftware.sp?catid=SW32K3-STDSW-D
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3)  DOWNLOAD:  S32DS ( S32DS 3 .4 )  AND K3  RTD 

Download latest version of RTD

Download S32 Design Studio Installer
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4)  INSTALL:  S32DS 3 .4  AND S32K3 SUPPORT PACKAGE

− “Automotive SW - S32K3 - S32 Design Studio”

▪ Step 1: Run “S32 Design Studio v3.4 Windows installer” 

• “S32DS.3.4_b201217_win32.x86_64.exe” 

• License Keys => Activation Code.

▪ Step 2: : Install “S32 Design Studio 3.4 development packages for offline use, support for S32K3 family” in S32DS3.4:

• After the installation was completed, open the S32DS3.4 and go to Help => Install New Software
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4)  INSTALL:  S32DS 3 .4  AND S32K3 SUPPORT PACKAGE

▪ Step 3: Look for the available software

• Drop down on the menu

• Select “S32DesignStudio - http://www.nxp.com/lgfiles/updates/Eclipse/S32DS_3.4”
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4)  INSTALL:  S32DS 3 .4  AND S32K3 SUPPORT PACKAGE

▪ Step 4: Choose the S32DS S32K3xx development package

• Select the S32DS S32K3 development package 3.4.1 and click Next 
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4)  INSTALL:  S32DS 3 .4  AND S32K3 SUPPORT PACKAGE

▪ Step 5: Install the S32DS S32K3xx development package

• Select the option “Update my installation to be compatible with the items being installed” and click Next 
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4)  INSTALL:  S32DS 3 .4  AND S32K3 SUPPORT PACKAGE

▪ Step 5: Install the S32DS S32K3xx development package

• Now you can review the installation details. Click Next 
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4)  INSTALL:  S32DS 3 .4  AND S32K3 SUPPORT PACKAGE

▪ Step 5: Install the S32DS S32K3xx development package

• Accept the license and click Finish 
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5)  INSTALL:  RTD FOR S32K3 IN  S32DS 3 .4

▪ Step 1: Install “S32K3 Real Time Drivers (RTD)” in S32DS3.4:

• Open the S32DS3.4 and go to Help => Install New Software

• Click on the “Add” button. 
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5)  INSTALL:  RTD FOR S32K3 IN  S32DS 3 .4

▪ Step 2: Look for the available software

• Click on the “Archive” button and look for the SW32K3_RTD_4.4_1.0.0_DS_updatesite_D2110 file inside your files. Remember 

that we downloaded the S32K3 RTD 1.0 package from the NXP official website (Slide 20)
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5)  INSTALL:  RTD FOR S32K3 IN  S32DS 3 .4

▪ Step 2: Look for the available software

• Select a name to identify this new package. For example, “S32K3 RTD 1.0”

• Remember to select the SW32K3_RTD_4.4_1.0.0_DS_updatesite_D2110 file and click “Add”
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5)  INSTALL:  RTD FOR S32K3 IN  S32DS 3 .4

▪ Step 3: Choose the S32DS S32K3xx RTD package

• Select the S32 Design Studio S32K3 RTD package and click Next 
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5)  INSTALL:  RTD FOR S32K3 IN  S32DS 3 .4

▪ Step 4: Install the S32DS S32K3xx RTD package

• Now you can review the installation details. Click Next 
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5)  INSTALL:  RTD FOR S32K3 IN  S32DS 3 .4

▪ Step 4: Install the S32DS S32K3xx RTD package

• Accept the license and click Finish 
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6)  CONFIRM:  RTD F ILES

User manual

Example projects

Driver source code

After installation, the RTD for S32K3 files can be found in the following path:

C:\NXP\S32DS.3.4\S32DS\software\PlatformSDK_S32K3_2021_10
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REAL-TIME DRIVERS (RTD) 

for S32K3
EXAMPLE PROJECTS
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IM PORT EXIST ING EXAM PLE PROJECTS

• File → Import → General → Existing Projects into Workspace → Next
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IM PORT EXIST ING EXAM PLE PROJECTS

Example projects path:

C:\NXP\S32DS.3.4\S32DS\software\PlatformSDK_S32K3_2021_10\SW32K3_RTD_4_4_1_0_0_D2110\Can_TS_T40D34M10I0R0\examples\S32DS

“examples\EBT” is for EB tresos example project and “examples\S32DS” is for S32DS example

Recommend to select “Copy projects into workspace” to save original example project for reference

Available SDK examples:

− adc_ip_example

− Can

− Dio_example_DS

− Eth_Example_DS_001

− FLS_IP_C40_Example_001

− FLS_IP_QSPI_Example_001

− Gpt_example_DS

− I2c_CodeDrop_example_DS

− Icu_example_DS

− dma_ip_transfer

− Power_Ip_Example_CT

− Clock_Ip_Example_CT

− Port_example_DS

− Ip_Lpspi_example_DS

− swt_ip_interrupt
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CREATE AN S32DS PROJECT FROM  EXAM PLE

File → New → S32DS Project from Example Select the RTD version and example project 
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GENERATE CODE FOR EXAM PLE PROJECT

Step1: 

check or update configurations 

for PIN, Clock, and Peripherals.

Step2: 

Click “Update Code” to Generate 

code for the configuration.

Double click the “mex” file to open SDK configuration tool.
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BUILD AND DEBUG THE EXAM PLE PROJECT

Build the project Configure Debugging Download and Debug the example project
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REAL-TIME DRIVERS (RTD) 

for S32K3
CREATING NEW PROJECTS
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CREATE NEW PROJECT

Select MCU S32K344

Set project name.
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SELECT SDK FOR S32K3XX NEW PROJECT

Select the desired RTD version (“RTD_Dxxxx_xxxx”) for the new project.
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OPEN SDK CONFIG TOOL

Double click the “.mex” file to open SDK config tool



4 4PUBLIC

S32DS CONFIGURATION TOOL

Click the button on top right to switch between different configuration tools and source code editor.

Edit source code

Pins configuration

Clock configuration

Peripheral configuration
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REAL-TIME DRIVERS (RTD)

Learn more at nxp.com/RTD

Join us at NXP Connects! 

Registration now open.

NXP Connects EMEA: Nov 9-10, 2021

NXP Connects AMEC: Nov 10-11, 2021

NXP Connects APAC: Nov 16-17, 2021

http://www.nxp.com/RTD
https://www.nxp.com/company/about-nxp/events/nxp-connects:NXP-CONNECTS
https://www.nxp.com/company/about-nxp/events/nxp-connects/nxp-connects-emea:NXP-CONNECTS-EMEA
https://www.nxp.com/company/about-nxp/events/nxp-connects/nxp-connects-2021-amec:NXP-CONNECTS-AMEC
https://www.nxp.com/company/about-nxp/events/nxp-connects/nxp-connects-apac:NXP-CONNECTS-APAC
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